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Introduction 
Adobe Dreamweaver CS4 is the widely used industry standard program for website creation. For 
both beginners and experienced users, Dreamweaver offers the ease and flexibility to create a 
variety of websites. The added ability to integrate other Adobe Creative Suite software such as 
Photoshop, Illustrator, and Flash into the final page design is another benefit of the program. 
 
Site management involves more than just getting the site online. It also involves ensuring that 
problems are found and  fixed before publishing the site. Dreamweaver makes this process easy 
by checking for certain problems to ensure that the site will run smoothly. Only once this has 
been completed should a host be chosen and the files be uploaded to a live server. 

Downloading the Data Files 
This handout includes sample data files that can be used for hands-on practice. The data files are 
stored in a self-extracting archive. The archive must be downloaded and executed in order to 
extract the data files. 

 The data files used with this handout are available for download at 
http://www.calstatela.edu/its/training/datafiles/dreamweavercs4p5.exe. 

 Instructions on how to download and extract the data files are available at 
http://www.calstatela.edu/its/docs/download.php. 

Attaching Word Documents 
Dreamweaver is in no way a word processor, so most work that involves text will be done using 
a word processor such as Microsoft Word. Once the text has been checked for spelling and 
grammar, it can be inserted into a web page in various ways. 

Importing a Word File (Windows Only) 
Dreamweaver CS4 enables users to import Microsoft Word documents (.doc and .docx) into a 
web page. The advantage of this method is that users can choose whether or not to keep the 
formatting of the text. 
 
To import the site into Dreamweaver: 

1. Start Adobe Dreamweaver CS4. 
2. Click the Site menu and select Manage Sites. The Manage Sites dialog box opens. 
3. Click the Import button to locate the site definition file. The Import Site dialog box 

opens. 
4. Navigate to the data files folder, locate and select the LakerFanSite5.ste file, and click 

the Open button. 
5. If prompted, select the appropriate local root folder and images folder for the site, and 

then click the Select button. 
6. In the Manage Sites dialog box, click the Done button to import the files into the Files 

panel. 
 
To import a Word document into a web page: 

1. In the Files panel, expand the LakerFanSite5 folder, and then double-click the 
Attach_article.html file to open it. 

http://www.calstatela.edu/its/training/datafiles/dreamweavercs4p5.exe�
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2. Place the insertion point inside the main content area (beige area). To ensure that the 
insertion point is properly placed, type temporary text in the main content area. Or, use 
the arrow keys to move the insertion point into the main content div tag. 

3. Click the File menu, point to Import, and select Word Document. The Import Word 
Document dialog box opens. 

4. Select the Attach_doc.doc file. 
5. Click the Formatting arrow and select Text, structure, full formatting from the list 

(see Figure 1). 
6. Click the Open button. The Word document is imported, complete with formatting. 

  
Figure 1 – Import Word Document Dialog Box 

NOTE

Figure 2

: This method requires having a version of Microsoft Word 97 or higher and that the 
document be no more than 300 kilobytes. Additionally, this method accesses Word (opens the 
program and then closes it). In some cases, this causes Dreamweaver or Word to crash (see 

). It is recommended to save the document before importing it into Dreamweaver. 

 
Figure 2 – Report Error Dialog Box 

Site Reports 
Running a site report in Dreamweaver allows users to check for several types of errors such as 
missing Alt text and untitled documents. Once the problem areas have been found and fixed, the 
report can be run again to ensure all problems have been resolved. 
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NOTE

 

: Pages do not need to be open to run a site report in Dreamweaver. Only the site must be loaded 
beforehand. 

To run a site report: 
1. Click the Window menu, point to Results, and select Site Reports. The Site Reports tab 

of the Results panel displays (see Figure 3). 

 
Figure 3 – Site Reports Tab of the Results Panel 

2. Click the Reports button  located in the upper-left corner of the Results panel. The 
Reports dialog box opens (see Figure 4). 

3. Click the Report on arrow and select Entire Current Local Site from the list. 
4. Under HTML Reports, select the Missing Alt Text and Untitled Documents check 

boxes. 

 
Figure 4 – Reports Dialog Box 

5. Click the Run button. The errors are listed in the Results panel (see Figure 5). 

 
Figure 5 – Error Report 
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To fix the errors: 
1. In the Results panel, double-click the index.html file with the Missing “alt” attribute 

description. This automatically opens the document in Split view with the error 
highlighted. 

2. In the Properties panel, type Laker Banner in the Alt box and press the Enter key (see 
Figure 6). 

 
Figure 6 – Adding Missing Alt Text 

3. In the Results panel, double-click the next error with the Empty document title 
description. 

4. In the Properties panel, type Laker Fan Site in the Title box and press the Enter key. 
5. Run the report again. If the errors have been resolved, the report should be clean. 

NOTE: Other reports such as Accessibility may be run as well, depending on the type of page 
(personal, professional, corporate) and the type of audience expected to visit the page. For more 
information on creating a site that is compliant to accessibility standards, visit 
http://www.calstatela.edu/accessibility. 

Checking Links 
Broken links can occur throughout the website creation process. One might forget to update 
links, rename files outside of Dreamweaver, or link sites to nowhere. 
 
To check for broken links: 

1. Click the Window menu, point to Results, and select Link Checker. The Link Checker 
tab of the Results panel displays. 

2. Click the Check Links button  located in the upper-left corner of the Results panel 
and select Check Links for Entire Current Local Site.  

3. Double-click the index.html file which includes a broken link (see Figure 7). 

 
Figure 7 – Broken Links Report 

4. In the Properties panel, type # in the Link box and press the Enter key (see Figure 8). 
5. Run the report again. The error is removed from the report. 

http://www.calstatela.edu/accessibility�
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Figure 8 – Updating a Link 

NOTE: If the URL or file is not known for a hyperlink, # can be entered instead as a temporary 
solution to maintain the hyperlink text. However, once the new web pages are established, users 
have to manually update the link. For example, the # should be changed back to news.html once 
the news.html page is created. 

Uploading Files to Bravenet 
Once a site has been completed and checked for errors, it is ready to be uploaded to a host so that 
it can be accessed online. Hosts can either be free or require some sort of monthly premium. For 
this lesson, a free host will be used. 

Creating a Bravenet Account 
First, an account needs to be created in order to use the Bravenet hosting service. Second, an FTP 
(File Transfer Protocol) account needs to be created in order to take advantage of this simple 
method of uploading files. 
 
To create a Bravenet account: 

1. Open a web browser and enter http://www.bravenet.com in the Address bar. 
2. Under Website Hosting, click the Get Hosting! link. 
3. Under bravehost, click the get bravehost link. The page changes and displays all their 

different services and prices.  
4. Under Free, click the SIGNUP NOW! link (see Figure 9). 

 
Figure 9 – Bravenet Free Account 

5. On the signup page, fill out the registration form and click the join bravenet link. After 
skipping the advertisements, the page should look like Figure 10. 

http://www.bravenet.com/�
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Figure 10 – Welcome Screen 

6. Under Free Web Hosting, click the Get Free Hosting link which should redirect to the 
validation page. 

7. Enter the validation code in the text field and click the Validate Account link. The 
validation code is sent by Bravenet to your e-mail account. 

8. On the Congratulations page, select the newsletters that you wish to subscribe to and 
click the button at the bottom to continue on to the members area. 

9. Once in the members area, click the websites tab located at the top of the page (see 
Figure 11). 

 
Figure 11 – Websites Tab 

10. Click the Build a new website link. A window opens asking you to select an address for 
the site (see Figure 12). 
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Figure 12 – Selecting an Address for the Site 

11. Click the Use a subdomain link and type a desired name in the Enter a subdomain box. 
The domain .bravehost.com will be included in the web address (URL) of the site. 

12. Click the create subdomain button. 

Creating an FTP Account 
A File Transfer Protocol (FTP) account must be made through Bravehost as well. This is a 
separate account from the Bravehost.com account. This FTP account will allow users to securely 
access their remote site from the Dreamweaver CS4 program and to transfer files from a user’s 
computer to the remote site. 
 
To set up an FTP account: 

1. Click the ftp tab at the top of the Bravenet page. The FTP Manager page displays. 
2. Click the New ftp account link. The Create an FTP account window opens (see Figure 

13). 

 
Figure 13 – Creating an FTP Account 

3. Type a username and password in the Username and Password boxes, respectively. 
NOTE

Figure 14
: Take note of the FTP username. All characters, including the numbers added to the end of 

the entered username, must be remembered for future use in Dreamweaver (see ). 
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4. Click the create ftp account button. 

 
Figure 14 – FTP Username and Server/Hostname 

Setting Up Remote Info 
Setting up the remote site provides the necessary information for Dreamweaver to access the 
online folder which will host the site. Once this has been established, uploading becomes a 
simple process that can be achieved directly from within Dreamweaver. 
 
To set up Remote Info: 

1. In the Files panel, double-click the list box displaying LakerFanSite5 (see Figure 15). 
The Site Definition for LakerFanSite5 dialog box opens. 

 
Figure 15 – Opening the Site Definition Dialog Box 

2. Click the Advanced tab. 
3. Select Remote Info from the Category list on the left. 
4. Click the Access arrow and select FTP from the list. 
5. Type the necessary information in the FTP host, Host directory, Login (username), and 

Password boxes (see Figure 16). 

 
Figure 16 – Entering Remote Information 

6. Click the Test button to test the FTP connection. 
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7. If prompted, click the OK button in the Windows Security Alert dialog box to allow 
Dreamweaver security accesses (see Figure 17). 

 
Figure 17 – Windows Security Alert Dialog Box 

8. Click the OK button and refresh the cache. 

Uploading a Site 
Once a connection has been established, the site files can be uploaded to the remote folder. 
Dreamweaver’s Files panel allows for easy uploading and viewing of files on both the local and 
remote site. 
 
To upload the pages: 

1. In the Files panel, click the Expand button  to expand the panel (see Figure 18). 

 
Figure 18 – Expanded Files Panel 

2. Click the Connect button  to connect and view the files on the remote site. 
3. On the Remote Site side (left side), expand the web folder to display the 

yoursitename.bravehost.com folder. 
4. Select the index.html and Text_Look.css files, as well as the images folder on the Local 

Files side (right side). 
5. Drag the files to the yoursitename.bravehost.com folder (see Figure 19). 
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Figure 19 – Transferring Files to the Remote Site 

6. When the Dependent Files dialog box opens, click the Yes button (see Figure 20). 

 
Figure 20 – Dependent Files Dialog Box 

7. Click the Disconnect button  to disconnect from the remote host. 
8. Test the site by opening a web browser (e.g., Internet Explorer or Firefox) and entering 

the URL in the Address bar. 
9. If there are any errors, fix the problems in the local files, and then upload the files again. 
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